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Overview of SpinFire Convert 
 

About SpinFire Convert 

   
 
SpinFire Convert is a world leader in the field of Engineering Data Services and Solutions. This 
leadership position stems from the quality of our technology and the people in the company. 
Quality comes not only from the skills and commitment of our staff, but also from the vigorous 
industrial use of our technology & services by world leading customers.  
 
We are proud that the vast majority of the world's leading Automotive, Aerospace, Defense, 
Power Generation and Transportation companies and their Supply chains use our products and 
services daily. Working closely with our customers, to both fully understand their requirements 
and feed their input into our development processes has significantly contributed to our 
technology and industry knowledge.  
 
 SpinFire Convert has strong relationships with the major CAD and PLM vendors, including 
Autodesk, Dassault Systemes, ICEM Technologies (a Dassault company), PTC, SolidWorks, Spatial 
Technology and Siemens PLM Software. These relationships enable us to deliver best-in-class 
services and solutions to engineering companies worldwide.  
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CAD PROCESSING PRODUCTS 

 

• Documentation 
• Knowledge Base 
• Archived Documentation 

 

• Documentation 
• Knowledge Base 
• Archived Documentation 

  

CAD VIEWING PRODUCTS 

 

 

• Documentation 
• Knowledge Base 
• Archived Documentation 

 

• Documentation 
• Knowledge Base 
• Archived Documentation 

https://docs.techsoft3d.com/spinfire/publish/index.html
https://techsoft3d.atlassian.net/wiki/spaces/EV/overview
https://techsoft3d.atlassian.net/wiki/spaces/psappss/pages/4089151497/Archived+Documentation
https://docs.techsoft3d.com/spinfire/convert/index.html
https://techsoft3d.atlassian.net/wiki/spaces/SCH/overview
https://techsoft3d.atlassian.net/wiki/spaces/psappss/pages/4089151497/Archived+Documentation
https://docs.techsoft3d.com/spinfire/insight/index.html
https://techsoft3d.atlassian.net/wiki/spaces/SF1100/overview
https://techsoft3d.atlassian.net/wiki/spaces/psappss/pages/4089151497/Archived+Documentation
https://docs.techsoft3d.com/spinfire/xr/index.html
https://techsoft3d.atlassian.net/wiki/spaces/sfxh/overview
https://techsoft3d.atlassian.net/wiki/spaces/psappss/pages/4089151497/Archived+Documentation
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The CATIA V5 <> JT Translator 
 
The CATIA V5 to JT translator may be installed on a number of machines each accessing a central 
network-floating license. 
 
The CATIA V5-JT Translator is a bi-directional direct database converter between the Dassault 
Systèmes CATIA V5 Modelling Application and the JT file format, used by the Siemens 
Teamcenter Visualization products.  
 
It enables the user to convert all forms of 3D Mechanical Design Geometry and Assembly data, 
together with system defined attribute information, colour information, between these two 
systems. This product is designed for companies using CATIA V5 who have selected JT to be their 
main method of collaboration and communication between OEMs and their customers or 
suppliers.  
 
It is also a major method of visualization and therefore companies using JT based solutions need 
to translate their CATIA V5 data into the JT format.  
 
The translator can be invoked in either an interactive or batch mode with the command line 
interface allowing the conversion process to be integrated into any process oriented operation. 
Alternatively, from SpinFire Convert version 18.0 the conversion process may be operated by 
using the new Unified Interface. 
 

Primary Product Features 

• Converts all types of geometry, wire frame, surfaces, trimmed surfaces (faces) and solid 
models.  

• Converts assembly structure between both systems. 

• Converts attribute data including colour and layer information.  

• Integrated with the CATIA V5 installation.  

• The conversion process can be run Interactively, Batch Mode or using the new Unified 
Interface  

• Command line interface allows process integration.  

• Data can be filtered by layer and entity type during processing. Geometry can be filtered 
and selectively processed.  

• Uses the CATIA V5 API and Siemens JTOpen API to read and write data.  

• In creating JT files a number of data types can be generated. A facetted representation, a 
JT Brep definition or an XT Brep definition. As standard a facetted representation is 
created with the user selecting whether JT or XT Brep definition is created. Converts all 
types of geometry, wire frame, surfaces, trimmed surfaces (faces) and solid models. 

 

  



User Guide: CATIA V5 <> JT 

 

© 2026 Techsoft3d. All Rights Reserved TS 05_0043_2 
 

Primary Product benefits? 

• Being a direct database converter all pre and post processing is eliminated, saving time.  

• Reduce costs due to processing time and increase overall conversion success levels by 
filtering input data and focusing the conversion to only those elements required.  

• Reduce costs and risks associated to accessing the wrong version of data by integrating the 
conversion process into a related business processes.  

• With over 30 years of industrial use SpinFire Convert (formally Theorem) translation products 
robustness and quality is well proven, reducing your business risk. 

 
 
This document will focus specifically on guidance for the use of the Visualize 3D for CATIA V5 – JT 
product.  For information regarding any SpinFire Convert product ranges please contact: 
sales-spinfire.applications@techsoft3d.com 

 
  

mailto:sales-spinfire.applications@techsoft3d.com
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Getting Started 
 

Documentation & Installation Media 

 
The latest copy of the User Guide documentation can be found on our web site at: 
https://docs.techsoft3d.com/spinfire/convert/index.html 
 
Each product has a specific link that provides user documentation in the form of PDF and 
Tutorials. 
 
The latest copy of SpinFire Convert software can be found via the link above and by searching for 
the specific product. Each product has a specific link to the Product Release Document, which 
contains a link to the download location of the installation CD. 
 
Alternatively, you can request a copy of the software to be shipped on a physical CD. 
 

Installation 

The installation is run from the .msi file download provided. For full details of the installation 
process, visit https://docs.techsoft3d.com/spinfire/convert/index.html and select UI from the 
product selection list. 
 

License Configuration 

To run any product a valid license file is required. The Flex License Manager is run from the .msi 
file download provided. For full details of the installation process, visit 
https://docs.techsoft3d.com/spinfire/convert/index.html  
 

Using the Product 

To use the product, follow the documented steps found in this document or follow the online 
video tutorials which can be found from https://docs.techsoft3d.com/spinfire/convert/index.html 

 

 

 

 

 

  

https://docs.techsoft3d.com/spinfire/convert/index.html
https://docs.techsoft3d.com/spinfire/convert/index.html
https://docs.techsoft3d.com/spinfire/convert/index.html
https://docs.techsoft3d.com/spinfire/convert/index.html
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Using the Product 
 

Default Translations 

 
 

The Unified Interface can be started via the Start Menu – if a shortcut was added during 
installation. 
 
Alternatively, the Unified Interface can be run via a Windows Explorer selection in: 

<UI_installation_directory>\bin\Unified_Interface.cmd 
 
The following interface will be launched: 

 
 

The default layout is split into 4 primary areas, which can be altered to the users prefer: 
The simplest way to translate from CATIA V5 or JT is to drag a file from the file Browser Pane on 
to the Active Configurations for the translation you require.   

  

Default Translation – via the Unified Interface 

File 
Browser 

Active 
Configurations 

Output 
Logs 

Translation 
Activity 
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On completion, the Unified Interface will display the activity information and details from the log 
file created during the translation, if requested, in the Translation Activity and Output Log panes, 
respectively. 
 
The generated output data can be located by selecting the translation from the Activity pane and 
opening the output folder: 
 

 
 

 
 
 

Running a translation via the command line can be carried out via the cad_run.cmd file located in 
the <installation_directory>\bin directory. The format of the command is as follows when 
translating from CATIA V5 to JT: 

<Translator_installation_directory>\bin\cad_run.cmd CATIA5[XX]_JT –i <input_file> -o 
<output_file> 

The format of the command is as follows when translating from JT to CATIA V5: 

Default Translation – via the Command Line 
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<Translator_installation_directory>\bin\cad_run.cmd JT_CATIA5[XX] –i <input_file> -o 
<output_file> 

(Note! Replace the [XX] seen in the example with the version of CATIA V5 you are using. E.g. for 
CATIA V5 R34 (V5-6 R2024), change to CATIA534): 
 

 
 
The example above will translate a CATIA V5 sample file provided within the installation and 
finish with the following screen output when successful: 
 

 
 
The file will be output to the target location.  In this case: 

C:\Temp\NIST_Output.jt 
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Translator Customization 
 
SpinFire Convert allows the information that is read from the source system and written to the 
target system to be tailored via a set of user specified arguments.  Commonly used arguments 
are supported via the Unified Interface, with Advanced Arguments being described within this 
document for use in the Unified Interface or via the Command Line invocation. 
 

Common Options for CATIA V5 to JT 

 
Within the Configuration Manager pane of the Unified Interface, arguments that can be specified 
when publishing CATIA V5 data into JT are grouped into 4 areas: 
 

• CATIA V5 Read – Those arguments that affect how data is read from CATIA V5 

• JT Write – Those arguments that affect how the data is written to JT 

• Entity Mask – Those arguments that allow specific read entities to be masked 

• General – Those arguments that are common to ALL Publishing activities regardless of 
source data. 

 
 
 
 

The image below shows the CATIA V5 Read arguments that are available, with their default 
settings: 
 

 
 
Each of these options is described below: 
 
 

Option Description 
Read PMI Enables PMI data read from the V5 file. (Default is ON). 

• Command Line Syntax: 

CATIA V5 Read Arguments 
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o dont_read_pmi – to turn off 

Note! When ‘read_pmi’ is enabled it also enables the ‘fill_pmi_arrows’, 
‘fill_pmi_text’  and ‘pmi_filled_text’ options.  These can be overridden by setting 
the Advanced arguments: ‘dont_fill_pmi_arrows’ and/or ‘dont_fill_pmi_text’ 

PMI Level A secondary argument to ‘Read PMI’ and allows control of the level of PMI to be 
read. Default is ALL when ‘Read PMI’ is marked as ON. 

• Options Available (command line syntax in italics and square brackets 
next to the option) 

o All - [read_pmi] 

o Part Level - [read_part_pmi] 

o Assembly Level - [read_assy_pmi] 

o Assembly Set (From CATPart) - [read_part_assy_pmi] 

o Assembly Set (All) - [read_all_assy_pmi] 

Read 
Captures 

A secondary argument to ‘Read PMI’ and allows the control over whether 
captures are read as part of the process. Default is ON when ‘Read PMI’ is 
marked as ON. 

• Command Line Syntax: 
o read_captures 

o dont_read_captures – to turn off 

 
Read FTA 
Reference 
Geometry 

Enables reading of FTA Reference Geometry (Default is Off) 

• Command Line Syntax: 
o read_geometry – to turn on 

Maintain 
CATIA V5 
Instance 
Names 

Honours CATIA V5 Tools->Options->Infrastructure->Product Structure->Nodes 
Customization panel settings (Default is Off) 

 

• Command Line Syntax: 

o ditto_naming V5 – to turn on 

Read Face 
Colours 

Read the face colours (Default is OFF) 

• Command Line Syntax: 
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o read_face_colours – to turn on 

Read Face 
Opactity 

Read the opacity of the face (Default is OFF) 

• Command Line Syntax: 
o read_materials – to turn on 

 
 
 
 

The image below shows the Write JT arguments that are available, with their default settings: 
 

 
Each of these options is described below:  
 

Option Description 
Config File Allows a JT configuration file to be specified. 

Please see Appendix B for a full description of the JT config file 
format. 

• Command Line Syntax 
o -z [path_to_file] 

 
The image below shows the Masking arguments that are available, with their default settings: 
 

 
 

JT Write Arguments 

 

CATIA V5 to JT Entity Masking Arguments 
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Each of these options is described below:  
 

Option Description 
Mask File 
 

Specifies the Mask File to be written to, that can be referenced 
by future translations.  A Mask file MUST be specified if 
masking is required.  The first line in this file is OFF ALL ENT: 

• Command Line Syntax: 
o Mask <filename> 

Entity Types Translated Specifies a selection list from which to select which entity types 
are to be processed.  The following types are available: 
"POI","CUR",”SKI”,"SOL",”ISO”,"TEX","AXI" 

• Command Line Syntax: 
o Add any of the above to the specified mask file, 

one entry per line prefixed by the word ON, e.g. 
ON POI to ensure they are considered in the 
translation 

Layers Translated Specifies a selection list from which to select which layers are 
to be processed.  

• Command Line Syntax: 
o A single entry of ON ALL LAY must precede any 

Layer Mask command. 

o Add a list or range of numbers representing 
layer to be processed to the specified mask file 
to ensure they are NOT considered in the 
translation e.g. OFF LAY 114,149,166,167,168 

Convert NO SHOW 
Geometry 

Enables Hidden geometry to be processed (Default is Off) 

• Command Line Syntax: 
o Add the following entry to the Mask file: 

 ON NOSHOW 

Convert NO SHOW Structure Enables Hidden Assembly Structure to be processed (Default is 
Off) 

• Command Line Syntax: 
o Add the following entry to the Mask file: 

 ON NOSHOW STR 

Convert NO SHOW PMI Enables Hidden PMI to be processed (Default = Off) 

• Command Line Syntax: 
o Add the following entry to the Mask file: 

  ON NOSHOW PMI 
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The image below shows the General arguments that are available, with their default settings. 
 
Each of these options is described below: 
  

Option Description 
Mass Properties 
 

Allows Mass Property information to be read from the source 
data and written as attributes (Default is OFF) 

• Command Line Syntax: 
o mprops 

Retain Assembly Structure Maintain the assembly structure during translation. (Default is 
ON) 

• Command Line Syntax: 
o offditto – to turn off 

Advanced Allows any of the Command Line Advanced arguments 
documented to be passed to the Unified Interface invocation.  

 
 
 

When using the optional CATIA V5 to JT PMI add-on module all CATIA V5 FTA data can be 
translated to JT PMI output. This includes the translation of 3D dimensions and annotations 
which are mapped to the equivalent JT PMI entities. In addition, CATIA V5 3D sections are also 
able to be translated. The CATIA V5 Capture definitions, which manage the visibility of selective 
FTA elements as well as the view zoom and orientation, are directly mapped to JT Model Views. 

 
 
 

When creating 3D dimensions and annotations with the CATIA V5 FTA module the user can 
create the text using either stick or filled text fonts. By default, the processing of CATIA V5 filled 
fonts will recreate the JT output using JT text glyphs. One benefit of using JT glyph-based text 
definitions is that when the model is reoriented, such that the initial view of the text is reversed, 
the user can select the annotations to be automatically reoriented. If the filled font 
representation was created with a simple polygon fill only the character outline would be 
reoriented and the polygon fill would remain in its original location making the output 
unreadable. 

CATIA V5 to JT General Arguments  

Processing CATIA V5 FTA data to JT PMI 

Options for Processing FTA Data with Filled Text 
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Picture showing typical CATIA V5 3D Dimensions and Annotations. Note, in the upper dimension 
the dimensions values 5.000 +- .008 are created using a filled text font. The characters “ST” in the 
frame are created using an unfilled stick font. 

 
Picture showing default JT output of V5 FTA data mapped to JT PMI representation 
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Picture showing the reorientation of the model with the text also reoriented. Note the text 
characters have been rotated 180 degrees and are now readable with filled character 
representation. 
 
To recreate the JT filled text using simple polygons, rather than JT text glyph representations, use 
the options pmi_glyphs_off pmi_polygons together. The output representation will appear filled 
and look correct when viewed in the authored orientation. However, filled text created with 
simple polygons, will not display correctly if the data is reoriented and the text switching in JT is 
selected. The picture below shows an example of the display when the data is rotated, and the 
text is reoriented. As you will see the simple polygon fill is still in its original orientation making 
the dimension unreadable.  
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When processing V5 FTA text data created with filled font definition the user can select to 
generate the JT text representation as outline text, therefore removing the internal rendering. 
This is achieved by using the option pmi_glyphs_off.  
 

 
Picture showing JT PMI with filled text rendered in outline only. Note the option pmi_glyphs_off 
also removes the filled arrowhead rendering. 
 
If you would prefer to maintain filled arrowheads and only impact the characters to be recreated 
in outline mode, then use the option dont_fill_pmi_text instead of the option pmi_glyphs_off. 
The resultant output is shown in the picture below with the text drawn in outline and the 
arrowheads filled. 
 

 
 
 

  

Options for Processing FTA Data using Outline Text 
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Common Options for JT to CATIA V5 

Within the Configuration Manager pane of the Unified Interface, arguments that can be specified 
when publishing JT data into CATIA V5 are grouped into 4 areas: 

• JT Read – Those arguments that affect how data is read from JT 

• CATIA V5 Write  – Those arguments that affect how the data is written to JT 

• General – Those arguments that are common to ALL Publishing activities regardless of 
source data 

 
 
 

The image below shows the JT Read arguments that are available, with their default settings: 
 

 
 
 

Each of these options is described below. 
 

Option Description 
Read PMI Reads 3D PMI. Default is OFF. 

• Command Line Syntax 
o read_pmi dim2_pmi 

Read Wireframe Read JT wireframe data. Default is OFF. 

• Command Line Syntax 
o read_wire_frame 

Read Points Read JT point data. Default is OFF. 

• Command Line Syntax 
o read_points 

JT Data Selection Select Brep or tessellated data read. Default is ‘Brep Preferred 
(then fine facet)’. 

JT Read Arguments 
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• Command Line Syntax 
o Brep Preferred (then Fine Facet): brep_pref 

o Brep preferred (then Fine Tristrip): 
brep_pref_tri 

o Brep Only: brep_only 

o Fine Tristrip: fine_tristrips 

o Coarse Tristrip: coarse_tristrips 

o Fine Facet: fine_facets 

o Coarse Facet: coarse_facets 

ULP Processing How to process ULP data in the JT part. Default is ‘Use Default 
Tessellation’. 

• Command Line Syntax 
o Use Default Tessellation: Default 

o Tessellate ULP: tess_ulp 

Config File Config File for Brep or ULP tessellation. 

• Command Line Syntax 

 -z [path to file] 

Convert XT Brep surfaces to 
NURBS 

Read XT Brep surfaces as NURBS surfaces (else read in native 
form). Default is ON. 

• Command Line Syntax 
o noprep – to turn off 

Convert XT Brep Edge 
Curves to NURBS 

Read XT Brep edge curves as NURBS curves (else read in native 
form. Default is ON. 

• Command Line Syntax 
o rd_native_edge – to turn off 

Filter via layer filter Supply layer filter(s) separated by commas and double quoted. 
Default is OFF. 

• Command Line Syntax 
o layer_filter 

 
 

 
The image below shows the CATIA V5 Write arguments that are 
available, with their default settings: 

 

CATIA V5 Write Arguments 
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Each of these options is described below: 
 

Option Description 
Output Geometry 
File Type 

Output Geometry file type. Default is CATPart. 

• Command Line Syntax 
o CATPart: output_type CATPart 

o Model: output_type model 

o Cgr: output_type cgr 

o Igs: output_type igs 

o CATShape: output_type CATShape 

o Tessellated: create_cgr 

Write Face 
Colours 

Writes face colours. Default is ON. 

• Command Line Syntax 
o FACE_COLOUR 

o SOLID_COLOUR – to turn off 

Show Reference 
Planes 

Creates reference planes. Default is OFF. 

• Command Line Syntax 
o Show: dont_blank_planes 

o No Show: Default 

Property 
Mapping File 

Path to Property Mapping File 

• Command Line Syntax 
o cad_prop_map_file <file> 

 
 

 
 JT to CATIA V5 General Arguments 
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The image below shows the General arguments that are available, with their default settings: 

 
The option is described below: 
 

Option Description 
Retain Assembly Structure Maintain the assembly structure during translation. (Default is 

ON) 

• Command Line Syntax: 
o offditto – to turn off 

Advanced Allows any of the Command Line Advanced arguments 
documented below to be passed to the Unified Interface 
invocation 
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Command Line Advanced Arguments  
 
Advanced arguments can be added to the Command Line or the UI General->Advanced field. 
 

CATIA V5 Advanced Arguments 

 
Argument Description 

convert_curves Converts curves to NURBS form 

convert_surfaces Converts surfaces to NURBS form 

dont_fill_pmi_arrows  Disables the read of filled arrow information  

dont_fill_pmi_text Disables the read of filled text information  

dont_read_captures Disables the read of PMI Capture information  

face_opacity Read face opacity 

no_face_colour Sets the default to SOLID colours 

noshow 
noshow_geom 
noshow_struct 
noshow_pmi 

Reads hidden geometry / structure / pmi 

output_mbd Allows sub-part specification tree information to be read and 
presented to JT as product structure information.   

read_geometry_edges CATIA V5 allows the display of shaded surfaces and edges. This 
option allows the translator to mimic this for FTA construction 
geometry by promoting the edge curves to standalone 
wireframe.  

cad_prop_map_file <file> Creates a cad property mapping file containing all attributes if 
one doesn’t exist.  

off_ditto Removes all assembly structure and collapses ALL geometry 
into a single selectable object 

 
 

JT Advanced Arguments 

Argument Description 
read_wire_frame Enables reading of Wire Frame entities 
read_ref_planes Reads reference planes  
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Translating Interactively from within CATIA V5 
 
The CATIA V5 to JT translator allows an active CATIA V5 Part or Assembly to be translated directly 
into JT or a JT Part or assembly to be imported, directly from the CATIA V5 application. 
In order to translate from within CATIA V5, the CATIA V5 application must be started from within 
a SpinFire Convert environment, so that the appropriate CATIA V5 menus are loaded. 
 
CATIA V5 can be started from a shortcut, if requested at installation time. Alternatively, it can be 
started via the script provided in the Translator installation at: 
 

<installation_directory>\bin\catia5r[version]_start.cmd  
 

(where [version] should be substituted for the version of CATIA V5 that you have installed – e.g. 
28, 29, 30, 31): 
 

 
 

Save As JT 

Once CATIA V5 has been started it is possible for a model to be saved to JT. To do this, the user 
selects the File -> Save As Menu Option. From the file browser window that opens, change the 
‘Save as type’ option to be jt (*.jt). 
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Once selected, press the ‘Save’ button to create the JT data. 

  
To add a user defined configuration to the process (created from the SpinFire Convert UI), this 
can be selected from the Tools>Options>Infrastructure>SpinFire Convert>Export JT menu. 
The process will then use this defined configuration to create the JT data as required. 
 

 
 

Open JT Data 

Once CATIA V5 has started it is possible for a model to be imported from JT using the File -> Open 
menu. Once selected, find the JT data you wish to import into CATIA V5 and select it from the file 
browser. When ready, press the ‘Open’ button from the menu to import.  
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To add a user defined configuration to the process (created from the SpinFire Convert UI), this 
can be selected from the Tools>Options>Infrastructure>SpinFire Convert>Import JT menu. 
The process will then use this defined configuration to create the JT data as required. 
 

 
 
 
 

SpinFire Convert Import and Export 

From the 'File' menu in CATIA V5 there are two options : ‘SpinFire Convert Import' and ‘SpinFire 
Convert Export'. This allows you to import JT data or export to JT from the File menu. Select 'File' 
> SpinFire Convert Export' or SpinFire Convert Import' to open the menu. 
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Provide output file name and log file location, then press 'OK' to export the data.  
 
To add a custom configuration, select the 'Configure' tab.  
 

 
 
This allows the user to select a configuration or create a new one by selecting the 'Launch 
Configuration Manager' option. Once a configuration is decided simply to select it from the list 
for it to be applied.  
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Appendix A – CATIA V5 Configuration 
 

Introduction 
 
This Appendix details how to define and configure the CATIA V5 and SpinFire Convert 
environment to work together. 
  

Conventions 
 
Release of CATIA V5  
To indicate a release of CATIA V5 the notation <XX> shall be used. This needs to be replaced with 
the specific release to be used i.e.31, 32, 33, 34, 35.  
 
Platform specific directory 
Within the installation directory of CATIA V5 there is a platform specific directory i.e. win_b64. 
This directory shall be referred to as <OSDS> in this Appendix. 
 
SpinFire Convert Installation directory 
The SpinFire Convert installation directory is set at installation time in the translator ts_env.bat 
file. This directory shall be noted as <%TS_INST%> in this Appendix. 
 

CATIA V5 Installation Directory  

Upon installation of a CATIA V5 product the user will be asked to specify the installation 
directory. This is the directory which contains the platform specific <OSDS> directory.  
 
Having selected the CATIA V5 installation directory via the browse button, the installation 
process will record the location of the CATIA V5 installation directory in the ts_env.bat file. This 
file is located in the SpinFire Convert installation directory. If the location of CATIA V5 
subsequently changes, the translator can be guided to the changed location by modifying this 
file using a text editor to modify the ts_env.bat that is located in the translator installation 
directory. 
 
If no entry is included for DSLICENSING a warning dialog will be displayed which warns of the 
empty field. Selecting Yes to continue will allow the installation to continue. 
 

 
 

Running CATIA V5 Translators  
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Before running the translator the user must run CATIA V5 interactively at least once to configure 
the CATIA V5 environment and license settings. This can be achieved by running the 
catia5r<XX>_start script as follows: 

<Translator_Installation_Directory>\bin\catia5r<XX>_start.cmd 
Once CATIA has been run the Translator can run as described in the relevant product User 
Guide. 
 

CATIA V5 Environment DIRENV & ENV  

The default location for CATIA V5 to store its global environment files is in the global directory: 
Windows 10: 

C:\ProgramData\DassaultSystemes\CATEnv 
Or 
%APPDATA%\CATEnv  

You can find this location by running: 
 

%CATIAV5_INST%\<OSDS>\code\bin\setcatenv -h 
 
The environment files are named in the form CATIA.V5RN.B<XX>.txt 
If when installing CATIA V5 the default environment file location was replaced with another 
location then this location needs to be indicated to the Translator by defining in the ts_env.bat 
the environment variable CATIAV5_DIRENV: 

 
set CATIAV5_DIRENV=/some/directory 

 
If the SpinFire Convert installation is needed to support multiple releases of CATIA. Then the user 
can define release specific locations using: 

 
set CATIAV5R<XX>_DIRENV=/some/directory 

 
SpinFire Convert attempts to create its own environment file called TheoremCatia5R<XX>.txt. 
The user must therefore have write permission to the CATEnv directory. If this is not possible an 
existing environment file can be specified using the variable CATIAV5_ENV. e.g.  

 
set CATIAV5_ENV=CATIA.V5R35.B35 

 
Note. the extension .txt is not required. The user can specify a release specific name using 
CATIAV5R<XX>_ENV e.g.  

set CATIAV5R35_ENV=CATIA.V5R31.B35 
 

Checking the CATIA V5 Environment  

 
A script is provided to check that the CATIA V5 environment is set up correctly. In a command 
window run the command script: 

 
%TS_INST%\bin\checkcatia5r<XX>env.cmd 
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Checking the SpinFire Convert Shared Library  

 
A script is provided to ensure that the CATIA V5 environment is compatible with the SpinFire 
Convert shared library.  In a command window run the command script: 
 

%TS_INST%\bin\checkcatia5r<XX>cadverter.cmd 
 

Successful output is an indication that the location for CATIA V5 has been specified to the 
SpinFire Convert translator correctly and that the correct version of the SpinFire Convert CATIA 
V5 translator products have been installed.  
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Appendix B – JT Configuration File 
 

Introduction 

 
A configuration file contains the settings for your translations. The configuration file can be 
specified using the command line option –config or -z. 
 
If this is not supplied the following directories will be searched in the specified order for the 
named configuration files: (TS_INST = Installed directory) 

tess.config in the directory where the translator is run 
tess.config in TS_INST\etc directory 
 

Two example config files are provided in the TS_INST\etc directory, a standard tess.config one, 
and one that illustrates the options required for large assembly processing, 
tessLargeAssm.config which is documented by some comments within it. 
 
The JT configuration file contains various sections, each containing different settings based on 
the section. 
 

The Setup Section 

 
The setup options in the configuration file define how your files are translated. The setup section 
is the first part of the configuration file and contains a series of standard translator options. 

 

 

1. Open an existing configuration file with a text editor. 

2. Edit the configuration file options listed in the table below. 

3. Save the configuration with a .config extension 

Option name Keywords Example 

EAITranslator EAITranslator { EAITranslator { 

OutputDirectory "path to directory" OutputDirectory = "/home/<user>/" 

CommonPartsPath "path to directory" CommonPartsPath= 
"/myaccount/jtparts/" 

chordalOption 

"RELATIVE" 

"ABSOLUTE" 
chordalOption = "RELATIVE" 

structureOption 

"PER_PART" 

"MONOLITHIC" 

"FULL_SHATTER" 

structureOption = "MONOLITHIC" 

To edit setup options 
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WriteWhichFiles 

"ALL" 

"ASSEMBLY_ONLY" 

"PARTS_ONLY" 

WriteWhichFiles = "ALL" 

  

compression 

true 

TRUE 

false 

FALSE 

compression = true 

triStripOpt 

  

true 

TRUE 

false 

FALSE 

triStripOpt = false 

seamSewing 

Note: Not available for 
Unigraphics. 

 

true 

TRUE 

false 

FALSE 

seamSewing = true 

seamSewingTol any integer seamSewingTol = 0.001 

includeBrep 

true 

TRUE 

false 

FALSE 

includeBrep = false 

brepPrecision 

"SINGLE" 

"DOUBLE" 
brepPrecision = "SINGLE" 

autoNameSanitize 

true 

TRUE 

false 

FALSE 

autoNameSanitize = true 

updateChangedPartsOnly 

true 
updateChangedPartsOnly = false 
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TRUE 

false 

FALSE 

verboseReporting 

true 

TRUE 

false 

FALSE 

verboseReporting = false 

writeAsciiAssembly 

true 

TRUE 

false 

FALSE 

writeAsciiAssembly = false 

singlePartsNoAssem 

true 

TRUE 

false 

FALSE 

singlePartsNoAssem = false 

smartLODgeneration 

true 

TRUE 

false 

FALSE 

smartLODgeneration = true 

autoLowLODgeneration 

true 

TRUE 

false 

FALSE 

autoLowLODgeneration = true 

numLODs any integer numLODs = 3 

close brace } } 
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The Filter Section 

 
The filter section of the configuration file contains the filename and metadata filtering 
information. Edit this section if you want to change how the translator sanitizes filenames and 
filters metadata keys. 

 
 
 

1. Open an existing configuration file with a text editor. 

2. Edit the configuration file options from the table below. 

3. Save the configuration with a .config extension 

 

Option name Keywords Example 

Filter Filter { Filter { 

FilenameSanitizeSet "string of characters" FilenameSanitizeSet = "abc123." 

FilenameSanitizeSetAdd "string of characters" FilenameSanitizeSetAdd = "4l" 

FilenameSanitizeSetDelete "string of characters" FilenameSanitizeSetDelete = "c" 

MetadataKey "string of characters" MetadataKey = "metadata key to exclude" 

close brace } } 
 

The Metadata Section 

 
The metadata section sets which metadata to attach to all parts, assemblies and nodes of the 
model. 
 

Note: Be sure to add these options to the configuration file in pairs: one line to define the 
metadata key and one line to define the metadata value. 

 

1. Open an existing configuration file (.CONFIG) in a text editor. 

2. Edit the configuration file options shown in the table below. 

3. Save the configuration with a .config extension 

 

Option name Keywords Example 

Metadata Metadata { Metadata { 

AddToParts "string of characters" AddToParts = "<metadata key>" 

AddToParts = "<metadata value>" 

To edit filter options 

To edit metadata options 
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AddToAssemblies "string of characters" AddToAssemblies = "<metadata key>" 

AddToAssemblies = "<metadata value>" 

AddToAllNodes "string of characters" AddToAllNodes = "<metadata key>" 

AddToAllNodes = "<metadata value>" 

close brace } } 
 
 

The Level of Detail Section 

 
The level of detail section of the configuration file contains the tessellation and simplification 
information for each level of detail in the file. 
 
This section consists of several sets of level of detail (LOD) information, and the number of these 
sets depends on the number you specified on the numLODs line in the configuration file. 
 
To edit level of detail options 

1. Open an existing configuration file in a text editor. 

2. Edit the configuration file options listed below. 

3. Save the configuration with a .config extension 

 

Option name Keywords Example 

LOD LOD "lod number" { LOD "1" { 

Level any integer Level = 1 

Chordal any number Chordal = 0.001 

Angular any number Angular = 25 

Length any number Length = 1 

FeatureSuppression any integer FeatureSuppression = 0 

Simplify any number Simplify = 0.60 

close brace } } 
 

The JT Options Section 

 
The JT Options section of the configuration file contains arguments for JT data. 
 
To edit special options 
 

1. Open an existing configuration file with a text editor. 
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2. Edit the configuration file options shown in the table below. 

3. Save the configuration with a .config file extension. 

•  

 

Option Keyword Example Default 
Value 

JtOptions JtOptions { JtOptions {   

AddSemanticPMI true 

TRUE   
  

false  

FALSE 

AddSemanticPMI = true true 

AnnotationPlanesViewsetNam
e 

Character string AnnotationPlanesViewsetNa
me = “Views” 

Views 

AppendCADExtension true  

TRUE   
  

false  

FALSE 

AppendCADExtension = false true 

BrepType XT 

JT 

XTJT 

BrepType = true XT 

BrepWireframe true 

TRUE   
  

false  

FALSE 

BrepWireframe = false false 

CadPropertyMappingFile Character String CadPropertyMappingFile = 
"%TS_INST%\data\jt\jt_prope
rty_mapping.txt" 

 

CollapseHierarchy SOLtoDetail 
toSets 
toPart 
SURandFACtoDet
ail 
toPartOptimized 
expandPart 

CollapseHierarchy = 
SOLtoDetail 

SOLtoDetai
l 

DefaultLayerFilter "Character 
String" 

DefaultLayerFilter = “” “” 
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EnhanceColour true 
TRUE   
  
false  
FALSE 

EnhanceColour = true true 

ExpandPart true 
TRUE   
  
false  
FALSE 

ExpandPart = false false 

ExplodeSolidsToFaces true 
TRUE   
  
false  
FALSE 

ExplodeSolidsToFaces = false false 

ExternalDetailNaming Character string ExternalDetailNaming = “” “” 
FaceEdgeTol Real  FaceEdgeTol = 0.000006 0.000006 
FixDegenerateEdges true 

TRUE   
  
false  
FALSE 

FixDegenerateEdges = true  true  

FixSmallFeaturesOpenSolids true 
TRUE   
  
false  
FALSE 

FixSmallFeaturesOpenSolids = 
false 
  

false  

FixSmallFeaturesSolids true 
TRUE   
  
false  
FALSE 

FixSmallFeaturesSolids = false 
  

false  

ForceBodyCreation true 
TRUE   
  
false  
FALSE 

ForceBodyCreation = true true  

IncrementalSewing true 
TRUE   
  
false  
FALSE 

IncrementalSewing = true true 

IncrementalSewingNoOfIterati
ons 

Integer IncrementalSewingNoOfIter
ations = 5 

5  

JtBrepFixup true 
TRUE   
  
false  
FALSE 

JtBrepFixup = False False 

LayerFilter true LayerFilter = false false  
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TRUE   
  
false  
FALSE 

ModelViews true 
TRUE   
  
false  
FALSE 

ModelViews = true true 

NameRootNode true 
TRUE   
  
false  
FALSE 

NameRootNode = false false 

OutputUnits mm 
cm 
m 
inches 

OutputUnits = mm mm 

ParasolidTolerantModelling true 
TRUE   
  
false  
FALSE 

ParasolidTolerantModelling 
= true 

true  

ParasolidTolerantModellingFa
ctor 

Integer ParasolidTolerantModellingF
actor = 3 

3 

PlmxmlPart true 
TRUE   
  
false  
FALSE 

PlmxmlPart = false false  

PlmxmlPropertyMappingFile Character String 
  

PlmxmlPropertyMappingFile 
= 
"%TS_INST%\data\jt\plmxml_
property_mapping.txt" 

 

PmiAttributeMap true 
TRUE   
  
false  
FALSE 

PmiAttributeMap = false false 

PmiAttributeMapFilename "Character 
String" 

PmiAttributeMapFilename = 
“” 

 

PmiAttributeSplit true 
TRUE   
  
false  
FALSE 

PmiAttributeSplit = false false 

PmiInstAssoc true 
TRUE   
  
false  
FALSE 

pmi_inst_assoc = false false 
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PmiGlyphs 2D 
3D 
off 

PmiGlyphs = 3D 3D 

PmiPolygons true 
TRUE   
  
false  
FALSE 

PmiPolygons = false false  

ViewCalcs AUTO 
ON                              
OFF                             

view_calc_auto 
view_calc_on 
view_calc_off 

AUTO 

ProduceTessellatedOutput true 
TRUE   
  
false  
FALSE 

ProduceTessellatedOutput = 
false 

false  

ReuseSolids true 
TRUE   
  
false  
FALSE 

ReuseSolids = false false  

SavedViewsViewsetName "Character 
String" 

SavedViewsViewsetName = 
“Catpures” 

Captures 

SewParasolidBodies true 
TRUE   
  
false  
FALSE 

SewParasolidBodies = true true 

SewParasolidBodiesTol Real SewParasolidBodiesTol = 
0.01 

0.01 

ShineSetting Integer ShineSetting = 30 
  

30  

SimplifyGeometry true 
TRUE   
  
false  
FALSE 

SimplifyGeometry = false false  

SplitDiscontinuousSurfaces true 
TRUE   
  
false  
FALSE 

SplitDiscontinuousSurfaces = 
false 

false  

StructureOutputType JT 
PLMXML 
PLMXMLJT 
STEPBOM 
STEPBOM_E2 

StructureOutputType = JT JT 

SubNode true 
TRUE   
  
false  

SubNode = false 
  

false  
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FALSE 
UseInstanceNames true 

TRUE   
  
false  
FALSE 

UseInstanceNames = false 
  

false 

FlushRootNodeColour true 
TRUE   
  
false  
FALSE 

FlushRootNodeColour = 
false 

false  

ExplodeSolidIntoFaces true 
TRUE   
  
false  
FALSE 

ExplodeSolidIntoFaces = 
false 
  

false  

AddSolidNodes true 
TRUE   
  
false  
FALSE 

AddSolidNodes = false false  

WriteSubAssyFiles true 
TRUE   
  
false  
FALSE 

WriteSubAssyFiles = false false 

create_cadid true 
TRUE   
  
false  
FALSE 

create_cadid = false false  

cadid_attr Character String cadid_attr = “” 
 

cadid_fname Character String cadid_fname = “” 
 

close brace } }   
 
 

The Catia5 Options Section 

 
The Catia5 Options section of the configuration file contains arguments for Catia5 data. 
To edit special options 
 

1. Open an existing configuration file with a text editor. 

2. Edit the configuration file options shown in the table below. 

3. Save the configuration with a .config file extension. 

 

Option Keyword Example Default 
Value 
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Catia5Options Catia5Options { Catia5Options {   

ApplyTrimmingLimits true 

TRUE   
  

false  

FALSE 

ApplyTrimmingLimits = false false 

AssemblyReportFilename Character string AssemblyReportFilename = 
“” 

 

ConvertSurfaceFaceLimits On 

Off 

Powerfill 

ConvertSurfaceFaceLimits = 
On 

On 

ConvertGenericFilletSurfaceTo
l 

Real ConvertGenericFilletSurfaceT
ol = 0.0001 

0.0001 

ConvertCurvesToNurbs true 

TRUE   
  

false  

FALSE 

ConvertCurvesToNurbs = 
false 

false 

ConvertCurvesToNurbsTol Real ConvertCurvesToNurbsTol = 
0.00001 

0.00001 

ConvertSurfacesToNurbs None 

Fillets 

Spheres 

Fillets+Spheres 

ConvertSurfacesToNurbs = 
None 

None 

ConvertSurfacesToNurbsTol Real ConvertSurfacesToNurbsTol 
= 0.00001 

0.00001 

DecimalSeparator dot 

comma 

DecimalSeparator = dot dot 

ExcludeList Character String exclude_list = “”  

ExcludeDisplayNameList Character String exclude_displayname_list = 
“” 

 

GenerateEmptyPart true 

TRUE   
  

false  

GenerateEmptyPart = false false 
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FALSE 

HybridJT true 

TRUE   
  

false  

FALSE 

HybridJT = false false 

IncludeList Character String include_list = “”  

IncludeDisplayNameList Character String include_displayname_list = “”  

InstanceNaming Character String InstanceNaming = “”  

MaximumNurbsDegree Integer MaximumNurbsDegree = 5 5 

MergeList Character String merge_list = “”  

MergeCGRVertices true 

TRUE   
  

false  

FALSE 

MergeCGRVertices = false false 

NonManifold true 

TRUE   
  

false  

FALSE 

NonManifold = false false 

NoShowList Character String Noshow_list = “”  

OpacityZero Real OpacityZero = 0.1 0.1 

OutputMBD true 

TRUE   
  

false  

FALSE 

OutputMBD = false false 

OutputMBDLeafNodes true 

TRUE   
  

false  

FALSE 

OutputMBDLeafNodes = 
false 

false 

PrintInfo true PrintInfo = true true 
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TRUE   
  

false  

FALSE 

ProcessCaptures true 

TRUE   
  

false  

FALSE 

ProcessCaptures = false false 

ProcessEsplice true 

TRUE   
  

false  

FALSE 

ProcessEsplice = false false 

ProcessElectrical true 

TRUE   
  

false  

FALSE 

ProcessElectrical = false false 

ProcessHybridJT true 

TRUE   
  

false  

FALSE 

ProcessHybridJT = false false 

ProcessLargeFaces HideLargeFaces 

AllowLargefaces 

DatumFaces 

True 

False 

ProcessLargeFaces = 
Datumfaces 

DatumFac
es 

ProcessLayers ALL_LAYERS 

                                        
A comma 
separated list of 
layer numbers(0 
- 255), using 
hyphen '-' to 
separate number 
ranges. 

ProcessLayers = ALL_LAYERS ALL_LAYE
RS 
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ProcessMotion true 

TRUE   
  

false  

FALSE 

ProcessMotion = false false 

ProcessOpenSolids true 

TRUE   
  

false  

FALSE 

ProcessOpenSolids = true true 

ProcessPMI true 

TRUE   
  

false  

FALSE 

ProcessPMI = false false 

ProcessPoints true 

TRUE   
  

false  

FALSE 

ProcessPoints = true true 

ProcessSolids true 

TRUE   
  

false  

FALSE 

ProcessSolids = true true 

ProcessWelds true 

TRUE   
  

false  

FALSE 

ProcessWelds = false false 

ProcessWireFrame true 

TRUE   
  

false  

FALSE 

ProcessWireFrame = true true 

ReadCachedCGR true ReadCachedCGR = false false 
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TRUE   
  

false  

FALSE 

ReadCGREdges true 

TRUE   
  

false  

FALSE 

ReadCGREdges = true true 

ReadFaceColours true 

TRUE   
  

false  

FALSE 

ReadFaceColours = true true 

ReadFTAReferenceGeometry true 

TRUE   
  

false  

FALSE 

ReadFTAReferenceGeometry 
= false 

false 

ReadHiddenData None 

Geometry 

Structure 

All 

ReadHiddenData = None None 

ReadInfiniteAxis true 

TRUE   
  

false  

FALSE 

ReadInfiniteAxis = false false 

ReadLeafNodeCGR true 

TRUE   
  

false  

FALSE 

ReadLeafNodeCGR = true true 

ReadMotion true 

TRUE   
  

ReadMotion = false false 
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false  

FALSE 

ReadNOA true 

TRUE   
  

false  

FALSE 

ReadNOA = false false 

ReadScanData true 

TRUE   
  

false  

FALSE 

ReadScanData = true true 

ReadSpaceReservations true 

TRUE   
  

false  

FALSE 

ReadSpaceReservations = 
false 

false 

ReduceNurbsSurfaceDegree true 

TRUE   
  

false  

FALSE 

ReduceNurbsSurfaceDegree 
= false 

false 

RetainAssemblyStructure true 

TRUE   
  

false  

FALSE 

RetainAssemblyStructure = 
true 

true 

RetainTrailingZeros true 

TRUE   
  

false  

FALSE 

RetainTrailingZeros = false false 

SimplifyCurves true 

TRUE   
  

false  

SimplifyCurves = false false 
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FALSE 

SimplifyProgressFile true 

TRUE   
  

false  

FALSE 

SimplifyProgressFile = false false 

SelectionSets true 

TRUE   
  

false  

FALSE 

SelectionSets = false false 

SurfaceChecking true 

TRUE   
  

false  

FALSE 

SurfaceChecking = false false 

SurfaceCheckingTol Real SurfaceCheckingTol = 0.001 0.001 

TextName true 

TRUE   
  

false  

FALSE 

TextName = false false 

TopGroupPerBody true 

TRUE   
  

false  

FALSE 

TopGroupPerBody = false false 

TrimFaceSurfaces true 

TRUE   
  

false  

FALSE 

TrimFaceSurfaces = true true 

UDFAxisSystems true 

TRUE   
  

false  

UDFAxisSystems = false false 
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FALSE 

ViewContext Default3D 

Unfolded 

ViewContext = Default3D Default3D 

close brace } }  

 
 

The Catia4 Options Section 

 
The Catia4 Options section of the configuration file contains arguments for Catia4 data. 
 
To edit special options 
 

1. Open an existing configuration file with a text editor. 

2. Edit the configuration file options shown in the table below. 

3. Save the configuration with a .config file extension. 

 

Option Keyword Example Default 
Value 

Catia4Options Catia4Options { Catia4Options {   

CatiaAssemblyPartsPath ASIS 

SET 

LAYER 

ENTITYTYPE 

VIEW 

ColourVisualizationMode = 
ASIS 

ASIS 

ColourVisualizationMode Character string AssemblyReportFilename = 
“” 

 

FacetColour true 

TRUE   
  

false  

FALSE 

FacetColour = false false 

GroupPipes groupPipelines 

groupPipes 

ungroupPipeline
s 

GroupPipes = groupPipelines groupPip
elines 
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ProcessEntityNames ALL_ENTITIES 

                                        
A comma 
separated list of 
ENTITY names 

ProcessEntityNames = 
ALL_ENTITIES 

ALL_ENTI
TIES 

ProcessFAC true 

TRUE   
  

false  

FALSE 

ProcessFAC = true true 

ProcessGPR true 

TRUE   
  

false  

FALSE 

ProcessGPR = true true 

ProcessLayers ALL_LAYERS 

                                         
CURRENT_LAYER
_FILTER 

                                          
A comma 
separated list of 
layer numbers(0 
- 255), using 
hyphen '-' to 
separate number 
ranges. 

ProcessLayers = ALL_LAYERS ALL_LAYE
RS 

ProcessModelNumber Integer ProcessModelNumber = 1 1 

ProcessNOSHOW true 

TRUE   
  

false  

FALSE 

ProcessNOSHOW = false false 

ProcessNRBS true 

TRUE   
  

false  

FALSE 

ProcessNRBS = true true 
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ProcessPIP true 

TRUE   
  

false  

FALSE 

ProcessPIP = true true 

ProcessPOI true 

TRUE   
  

false  

FALSE 

ProcessPOI = true true 

ProcessSetNames ALL_SETS 

                                        
A comma 
separated lists of 
SET names 

ProcessSetNames = 
ALL_SETS 

ALL_SETS 

ProcessSKI true 

TRUE   
  

false  

FALSE 

ProcessSKI = true true 

ProcessSOL true 

TRUE   
  

false  

FALSE 

ProcessSOL = true true 

ProcessSTR true 

TRUE   
  

false  

FALSE 

ProcessSTR = true true 

ProcessSUR true 

TRUE   
  

false  

FALSE 

ProcessSUR = true true 

ProcessWireFrame true ProcessWireFrame = true true 
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TRUE   
  

false  

FALSE 

UseColorMethod AS_FILED 

SET 

LAYER 

ENTITY 

UseColorMethod = AS_FILED AS_FILED 

close brace } }  

 

The General Options Section 

 
The General Options section of the configuration file contains general arguments. 
 
To edit special options 
 

1. Open an existing configuration file with a text editor. 

2. Edit the configuration file options shown in the table below. 

3. Save the configuration with a .config file extension. 

 

Option Keyword Example Default 
Value 

GeneralOptions GeneralOptions { GeneralOptions {   

MassProperties true 

TRUE   
  

false  

FALSE 

MassProperties = false false 

ProgressFileInformation true 

TRUE   
  

false  

FALSE 

ProgressFileInformation = 
true 

true 

ProgressFileWarnings  true 

TRUE   
  

ProgressFileWarnings = true true 



User Guide: CATIA V5 <> JT 

 

© 2026 Techsoft3d. All Rights Reserved TS 05_0043_2 
 

false  

FALSE 

ReportFilename Character String ReportFilename = 
”%TEMP%\report1.log” 

 

AdvancedOptions Chatacter String AdvancedOptions = “”  

close brace } }  
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Appendix C – Error Codes 
 

Common Error Codes 

 
When processing data, the command screen or log file will show a return code as a status of the 
translation. These are detailed below. 
 

Return Code Description 
0 Success 
1 Issues during write leg such as incomplete run or no arguments given 

 
2 Issue obtaining license 

 
3 Input file argument issue or failure to open Progress File 

 
4 Issue during read including no entities read 

 
5 Failure to located secondary process (aka vwr_3dpdf.exe or vwr_jt.cmd) 

 
6  
7 Failure to open CATIA V5 document 

 
8 Failure to find root node of CATIA V5 document 

 
9 Failure to start CATIA V5 session 

 
10 catia5cadverter.dll version doesn't match the catia5_XXX.exe 

 
11 CATIA V4 data given as input file but bi _V4MAIN license available 
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